Basics Lesson Three – Resizing and moving windows and Basic Word Processing
Parts of a Standard window
(lower case window refers to the boxes which open, not the operating system)
 Title Bar is the colored bar at the very top of a window.
or



o It contains the Minimize, Maximize, and Close buttons
o The title bar also displays the name of both the file and the program you are in.
The Menu Bar when present, is usually the line of icons "buttons" beneath the Title bar.

.



The most important to immediately be aware of:
 The FILE menu Prints, Saves, Opens files, and Starts a new document.
 The EDIT menu Cuts, Copies, Pastes, Deletes, Selects All, and most importantly
has the UNDO command.
 The VIEW menu allows various toolbars to show, and controls the appearance of
icons.
 The HELP menu holds helpful advice or instructions for each program.
The Standard Toolbar performs many of the most frequent operations, and is customarily



below the Menu bar.
o Contains the icon buttons which perform many of the most frequently used Menu bar
commands. Things such as New, Open, Save, Print, Cut/Copy/Paste, and Undo.
The Format Toolbar performs many of the most frequent style (formatting) changes.

o






o Changes font style, letter size (font size), text color, alignment, and BIU.
Windows 10 programs and Apps have mostly replaced those toolbars for "ribbons", which are
essentially more sophisticated and all‐displaying toolbars.
The window Borders & Corners are used for dragging and resizing.
o Remember to get right on the edge of that border, until the arrow changes.
The area you work, write, or draw in is called the Workspace.
The Scroll Bars change the vertical and/or horizontal part of the workspace currently in view.
o Scroll bars are present only if the workspace (used workspace, blank area does not
count) is larger than capable of being viewed all at once.
 Thus if the document is short but wide, only horizontal scroll bars (located at the
bottom of the workspace) are present.
 Similarly, vertical scroll bars (located usually to the right of the workspace) are
present only if the document it too long to viewed all at once.
 Scroll by either dragging the button within the bar up. Down, or sideways, or by
clicking repeatedly on the up, down, or sideways arrows at the extremes of each.
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Parts of a Standard window cont’d.
 Windows toolbars Pull‐down Menus supply numerous available options, such as the Font Style.



Clicking here causes the menu to appear.
Other typical items found within a window:
o Command Buttons
 These, by clicking on them,
instruct
Windows (or the window)
to do
something.
o Option Buttons
 Give choices on which to click, such as
Yes or No, OK or Cancel, Save or
Cancel, etc., again instructing
Windows of your desire.
o Dialog boxes
 These are boxes into which you must type or place some text, such as the Save
As box in which you must type the name for your document.
o List boxes or Drop‐down lists
 These drop‐down lists allow you to make choices of things like Font appearance,
Font size, the location to view, a place to save something in, or a file type to save
as. You will understand this more in the next (third) lesson. See the image
above under Pull‐down Menus.
o Check Boxes
 These are small boxes in which you place or remove a check, thus allowing some
change.
 You place or remove the
check by clicking within the
box (you must be precise).
 Frequently there are many
such boxes in a row, and as
many as desired can be checked.
o Radio Buttons
 These are usually two or more small round circles
into
which you can place a black dot in only one of the
group
(such either/or).
 These are used when you can have only one choice out of all the various choices.
 Again, you place the dot by clicking on the desired options. The dot moves to the
selected (clicked on) circle.
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Parts of a Standard window cont’d.
o Sliding Controls
 Here, just like the slide controls on a stereo or radio, by
placing the mouse arrow over the knob (of the slide), you
then drag the lever up or down, left or right, increasing or
decreasing such things as volume, speed of mouse
movement, etc.

can
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Manipulating Size or location of windows
 The three little boxes at the upper‐most right hand are the Close (X), the Maximize (square),












and the Minimize (‐) buttons for every window.
o "Close" command is obvious. When you are finished, SAVE your work and click the X.
o Maximize means to cause the window to enlarge, occupying the entire screen.
 Use this to see more of the program window at once.
 When it is maximized and you wish to return (called Restore) the window to the
original size, click on the now double square.
 When a double square, it is called the Restore button.
o Minimize causes the window to shrink to just a button on the Taskbar.
 To return it (restore it) to the screen, click on the Taskbar button with its name.
To move a window around the screen:
o With the cursor (arrow) inside the very top Title bar, drag the window to a new location.
If the window is too small, and you cannot see enough to work or read efficiently:
o Resize the window.
 Slowly move the arrow (cursor) across the edge or corner of a window.
 As you do, watch. The single arrow cursor will become a double‐directional
arrow  at the exact window border (edge).
 It is a vertical two‐directional arrow at the top or bottom. It is a horizontal two‐
directional arrow on the sides. It a diagonal two‐directional arrow when exactly
at the corner of a window.
 While it is two‐directional, drag with the mouse, larger or smaller, to the desired
size.
 It enlarges or shrinks the window in the respective direction.
 Drag the diagonal to maintain the aspect ratio (does not distort the
shape) of the window (such as with a photo).
Maximizing windows
o Clicking the square allows the maximum amount of the window to be seen at once.
o The window completely takes up the desktop, except usually for the taskbar.
 If the taskbar is hidden reveal it by hitting the LOGO key.
o Double‐clicking the Title bar also Maximizes or Restores "down" the window.
Minimizing windows and restoring them
o Minimizing closes the window down to just a box on the Taskbar.
o It is used to get the window entirely out of the way
o Clicking on the program button on the Taskbar opens it back up (restores)
o Clicking on the Taskbar name of an open window brings it to the front (the active
window), but a second click to the Taskbar button Minimizes it.
Show desktop by minimizing all windows.
Switch from window to window (or bring a window to the top) by either clicking on a part of
the visible window,
o Or click on the appropriately named button on the Taskbar
To close a window exits the program.
o It usually asks if you want to save the document you were working on (Say Yes, unless
you know you don’t want to save it).
o But get in the habit of saving it intentionally…and often.
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The below described techniques apply to all word processing: e‐mail, most other document creation
(spreadsheets, greeting cards, labels, envelopes), and even text‐entering boxes (save as boxes, address
bars such as Internet Explorer, forms, templates, etc.).
Basic Word Processing Concepts
 Use Page Setup for (go to File menu | Page Setup) (Word 2007 and later have no menus. Look
for Page Layout):
o Setting Margins (left, right, top, bottom)
o Orientation of the page


Portrait = page is upright
; thus height is greater than width
 This is the typical orientation for letters.













Landscape = page is turned horizontal
, thus width is greater than height
 This is best when documents need longer lines of data or information,
such as when doing a spreadsheet.
The cursor changes from an arrow (pointer) to an I‐beam when over an area into which you can
insert text (into which you can type).
o By positioning the I‐beam cursor over an area and clicking, it deposits an ‘Insertion
point" (a blinking vertical bar).
 It is ONLY at the Insertion point text is entered (from left to right).
 Only by clicking in a box and seeing the Insertion point can text be entered.
 In Word, double‐clicking in any area available for text, deposits the Insertion
point at that precise place, but ONLY in Word.
o If it remains an arrow, it is over a menu, a toolbar, a picture, or a margin, not a text area.
Remember any two‐directional arrow appearing when hovering over something (a line, a
border, or a divider means you can resize something.
o Resize the window.
o Drag a pane separator (or help window) left, right, up or down to improve a view.
o Drag a vertical separator left or right for revealing more information.
Entering text is just like using a typewriter (use the keys on the keyboard) except:
o Remember you can only insert text once the Insertion Point is present.
o Going to the next line occurs automatically (called "word wrap"). Just keep typing.
When you click within the area in which you wish to type and at the precise point you wish
characters to begin, (or the beginning of the document) the I‐beam leaves (deposits) a vertical
blinking bar called the "Insertion Point" onto the document. (Again, you can tell this is an area
available to type into by the fact the cursor appears as an I‐beam rather than an arrow.)
o It is at the Insertion Point, typed characters begin to be added (inserted) or replaced
("replacement mode" toggled on or off by hitting the Insert key on the keyboard).
o Understand the difference when typing, between using the Backspace or the Delete key:
 A Backspace key removes the character just left of (behind) the insertion point.
 A Delete key removes the character just to the right of the insertion point.
As you are typing, to create a new paragraph (not simply a new line), hit the ENTER key. The
Insertion Point (that vertical flashing bar) drops to the next line. When you start typing, the
document recognizes it as a new paragraph.
Remember, starting a new paragraph requires using the ENTER key.
o You can have indented paragraphs or paragraphs without indentation.
 Use the Format menu/Paragraph option.
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Basic Word Processing Concepts (cont’d)
 Again, re‐emphasizing, to simply move to the next line, unlike a typewriter, simply continue
typing (beyond what seems like the end of the line). Once the end of the current line is
reached, the Insertion Point moves automatically to the next lower line (a new line). This is
called "Word Wrap". In other words, the words "wrap" to the next line. And unlike using the
ENTER key (to move to the next line), it is not considered a new paragraph.
o Therefore, if you decide later to modify the text (change the size of the Font, or
Margins), the lines adjust automatically. Otherwise they would become jumbled, and
fragmented.
o The Enter key does not work like a return arm on a typewriter.
 It creates paragraph (which means something different on word processors), not
just a line shift.
 The Insertion Point (now a vertical blinking bar) can be moved about within the existing text in
a variety of ways. It may be moved:
o One character at a time by using the arrow keys (right, left, up, or down). Note that the
down arrow cannot take the Insertion point below the last existing line.
 And remember that last existing line may be blank. The computer still
recognizes it as a line. It does not know it is blank (no visible characters, only
spaces created by repeatedly hitting the Space bar, or additional lines created by
repeatedly hitting the ENTER or paragraph key).
o To any area within existing text (or created blank lines) by clicking the mouse where you
want to be.
o When using Word, double‐clicking anywhere in the blank document sets the Insertion
Point at the point where the mouse was double‐clicked. You can then begin typing or
inserting an object (such as a picture) there.
o Several keyboard keys, or key combinations also move the Insertion point:
 The HOME key moves the insertion point to the start of line it is currently on.
 The END key moves the insertion point to the end of the current line.
 Holding down the CTRL key, and while doing so striking the HOME key moves the
insertion point to the start of the entire document.
 Holding down the CTRL key, and while doing so striking the END key moves the
insertion point to the end of the entire document.
 Holding down the CTRL key while using the left or right arrow keys moves the
insertion point one full word at a time.
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Basic Word Processing Concepts (cont’d)
Standard Toolbar icons can be used (rather than the menus).
o The New icon
starts a new (blank) document.
o The Open icon
opens the dialog box, allowing you to navigate to and open any
previously created (or existing) document.
o The Save icon
repeatedly saves the document each time you click on it, replacing
the previous version with this new one.
o The Printer icon
instructs the computer to print a single copy of the entire
document (using the Default printer, assuming you have more than one printer).
 No printer dialog box comes up. It just starts printing one entire copy.
 Using the File menu | Print command, brings up a dialog box, allowing you to
adjust many things, including: change the number of copies, orientation of the
page (landscape vs. portrait), control which pages are printed (only select pages,
or in Word, only selected text), which (if more than one) printer is to be used,
and provide the opportunity to choose any other option or special feature the
printer may offer.
 See more discussion about printing below.





o The Print Preview icon
allows you to preview what your document will look like
when printed (including how many pages will print, and how much text will appear on
each page).
Be aware of the Vertical and Horizontal Scroll bars.
o They provide the way to scroll through a document which is too long to be entirely
viewed within a single screen (that which shows in the window at one time).
o When text seems to disappear, the Page often has simply jumped to an area devoid of
text, such as to the far right, or to the bottom. Try scrolling left or up (or both) to see if
the text is there.
Microsoft Word uses ribbons such as the one below, which combine many formatting tools as
icons (or buttons).
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Basic Word Processing Concepts (cont’d)
 Saving a File (Document)
o Go to The File menu | Save or Save As (or use the Save icon
o How is "Save" different from "Save As"?

).



o

o

o
o

The first time you save a document, whether clicking the icon
, or using the
File menu command of "Save" (or even "Save As"), the "Save As" dialog box
comes up. That is because Windows does not yet know what to call, or where to
store, the document. "Save" is the same as "Save As" at this point.
 Once you have saved the document the first time (it now has both name and
location saved), each time you Save, it simply overwrites (replaces) the last
version saved. Should you want different versions of the same document,
choose "Save As" (see below). By choosing the "Save As" command (there is no
Save As icon), it avoids overwriting (replacing) the original, and allows you to
make a new and separate copy (or version) of the document. To do so, it must
either be given a different name (add a number), or placed in a different
location, or both. This way, the original is not replaced. It is still there.
 If you made unwanted changes and wish to reopen to the prior appearance (get
back to where you were BEFORE making the changes), Do Not click Save or the
original (good) version will be lost, replaced by the unwanted (or changed)
document. To avoid this happening, close the program without saving the
document. As it closes, if it asks to save, say "No!
 This is why I advocate saving often, every time you are happy with a
change".
During the Save process, a dialog box will ask you where (into what folder) you want to
save your document. It offers initially to put it into the (My) Documents folder.
 Before clicking Save, pay attention to where it is going to be put.
 Remember where you saved it!
 Not remembering what place (which folder) you saved a previous document
creates one of the most common frustrations. Where is my document? I can’t
find my document.
The same dialog box will also ask you to provide a name for your document.
 Give it a descriptive name you can remember.
 Not too long
 Avoid too many abbreviations as well (later you won’t remember).
 Be concise. (As example: Don’t use "My trip to Chicago". Use "Chicago
Trip" or "Chicago Trip 2009".)
 As with the last example above, you may wish to include a date or year if there
will be more with the same name.
SAVE…SAVE…SAVE…You cannot save too often…only tragically not often enough.
If you were not sure when you had last saved it, you may wish to choose "Save As" and
keep the altered document as a second version of the first temporarily, thus keeping the
undesirable changes, but also any additional components (text or graphics) you entered
intentionally, and most likely will want to "copy and paste" into the original later rather
than need to re‐type.
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Basic Word Processing Concepts (cont’d)


The Formatting Toolbar displayed above, ("ribbons" vary slightly in color or appearance, but
tools are the same) allows you to choose changes in text appearance.
o Choose or vary the Font "style" you desire by clicking the down arrow
o Select a Font "size", or vary it for effect

.

o Bold, Italicize or Underline text by clicking on the B, the I, or the U
 Stop each by clicking the button again (first click starts,
second click stops the formatting).
o Change the Font "color" by clicking on the drop‐down arrow on
the right of the font color button



.

.

.

o Adjust the Alignment of text
.
o There are many other formatting items (icons) you can use to
create just the document you want.
If the program has a Format menu, it has additional options not
provided (thus hidden) from the traditional Formatting toolbar. To
avoid this, Microsoft and others are replacing the Format menu and
Formatting toolbar with ribbons, i.e. all formatting items on the Home ribbon, such as the one
displayed underneath.
o Here, all the tools are available, often on multiple ribbons as displayed by the tabs (such
as Insert, (Page) Layout, Mailings, View, etc.
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Basic Word Processing Concepts (cont’d)
 Printing your document
o Again, you can print the document either by clicking the Print icon
, or going to the
File menu, and choosing Print.
o The difference between the Print icon and the File | Print command is:


Using the printer icon
immediately prints one copy of the entire document
using the "Default" printer, no questions asked. The Print dialog box does not
appear.
 When using the File menu | Print command, the Printer dialog box appears
(opens), allowing a choice of which pages to print, how many copies to print,
and which printer to use (if more than one is attached or available to the
computer).
 It also allows you to change Printer Properties such as quality (draft,
better, best), paper size or type, and orientation (portrait, landscape).
 And allows taking advantage of special features your printer might have
(such as "duplex" (printing on both sides of the page).
o Again, before printing, you can preview the appearance the pages just as they are going
to print, using the Print Preview.
 Access the Print Preview windows either by the File menu | Print Preview
command, or by clicking the Print Preview icon
on a toolbar.
o A common occurrence is deciding to cancel print (you hit the icon by mistake, used the
wrong paper, or just need to make a change first)
 Canceling Print is more difficult than you might think.
 Canceling by using the printer icon on the computer usually is not successful.
 If the printer has a "Cancel" button, pushing that will work best.
 If no "Cancel" button on the printer, the fastest, most successful way to stop
printing is to remove the stack of available paper. Do not try to pull out the
page already printing. This results in the printer informing the computer it is out
of paper, and provides the option to cancel the printing.
 Even turning off the printer is unsuccessful. When it restarts, printing
resumes.
 In fact, sometimes when you attempt to print, nothing appears to
happen. However, when you restart the computer and/or printer, it
suddenly prints out all twelve print jobs you sent when you kept
clicking the Print icon with nothing happening.
o If you attempt to print and nothing seems to happen, before repeatedly clicking print,
restart the computer and see what happens. It often starts printing the document
requested.
o Remember, for the computer to recognize you asked it to print, you must be actively in
that program window (on which the icon sits).
 If you accidentally or on purpose shifted to another window, or the taskbar
or start menu, when you first click the icon print, you may have only
activated that window again. In that situation you may need to click or tap
the print icon once more, but not any more than that.
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Selecting Text or Objects
 Why select anything?
o In order to change text (not just adding a few characters), you must first tell the
computer which text you wish to change (or replace).
 When text (or text and graphics) is selected Windows lets you know by
"highlighting" the text or object. This is usually done with gray or a colored
background, or a color shade over the object (or change in appearance in some
way); any typing replaces any selected text (even typing a space replaces the text
with a blank space).
o In order to use the Cut/Copy/Paste commands (one of the most powerful Windows
tools, you will learn about below), thus rearranging text or objects, something must first
be selected.
 As an example, you may wish to repeat a section of text. In order to "copy"
(duplicate) the text elsewhere; it needs to be selected.
 Similarly, you may want to duplicate objects (icons, files, folders, pictures).
 You may wish to move text from one area to another (using Cut and Paste).
 Cut and Copy commands also work to move or copy files/folders (documents) to
another folder, drive, or disk.
 How To Select Text (or objects included within a text document)
o Drag the mouse over the text you wish to select (it will highlight ).
 Start at one end of the text, and then drag to the other end.
 Or start at one corner of the object and drag to the opposite diagonal
corner.
 This technique works for selecting text or objects anywhere.
 For example, it can be used either on word‐processing‐like documents, or web
pages to select text or items.
 It is the ONLY way to select something on web pages or from an e‐mail you are
reading.
 While word processing, it may be combined with the "SHIFT key/arrow"
technique (see below) to extend the selection, or de‐select (remove characters
from highlighted selection).
o Double‐clicking on a word will select only that word.
 Extend the selection (and highlighting) once the word has been selected by
holding down the SHIFT key and hitting the right arrow key. The "blue" extends
one character at a time. See more explanation below.
 Double‐clicking on a word works almost everywhere, to select that word.
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Selecting Text or Objects (cont’d)
o Use the SHIFT key and use the Arrow keys to make a selection.
 First place the cursor where you wish to begin selecting and click the mouse (an
insertion point appears).
 Now (before clicking anywhere else) hold down the SHIFT key. While holding the
SHIFT key down, hit the right, left, up or down arrow keys.
 Using the Left arrow selects to the left of insertion point, one character at
a time.
 Using the Right arrow selects to the right of the insertion point, one
character at a time.
 The Up arrow selects the entire line to the left of insertion point, then
one line at a time.
 And the Down arrow selects the entire line to the right of the insertion
point, then one line at a time
 The use of this SHIFT key technique works only in word‐processing or some other
document creation program (including e‐mail which you are creating…replies,
forwards, new mail)
 Using this SHIFT key in the opposite direction de‐selects from the end of a
selection already made (whether by dragging, or selecting with the SHIFT plus
arrows.
 Placing the cursor at the start of a selection (clicking at that site), then holding
the SHIFT key before clicking the end of where you wanted the selection to end,
selects all the text (or text and graphics) between the two clicks.
o Microsoft Word allows multiple selections at once using the CTRL key.
 Use it similar to selection of multiple objects (such as icons). First select the first
word or object, and then hold down the CTRL key before selecting another word,
line, paragraph, or object. Select multiple adjoining words or lines by dragging
(while the CTRL key is held).
 We will discuss selecting, as well as using the Cut, Copy, and Paste commands in
more detail later.
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Selecting Text or Objects (cont’d)
 Specific technique to Selecting icons or other objects (files, folders)
o The same dragging technique works.
 Start dragging just above (and to the left or right of) the first object to be
selected. An almost invisible box begins to appear.
 If you begin dragging while over the object (not to the side of it), the
object gets dragged instead of selecting it.
 Now drag to just below (and to the right or left respectively) the last object
desired for selection. In other words, drag a rectangle dotted box around all the
items wanted within the selection.
 For objects to be included in the selection, they merely have to be
"touched" by the "invisible" box, not entirely surrounded by it.
 This only works with objects next to each other. You cannot skip items
when dragging to select (but see below).
o Similar to use of the SHIFT key above, clicking on a first object selects it.
 Holding the SHIFT key and then clicking on the last object desired selects all
objects in between.
 You must not click on anything else in the window before holding down
the SHIFT key.
o By using the CTRL key, much in the way you used the SHIFT key, you can selectively pick
and choose your selections.
 Click on the first item (object) you wish to include in your selection.
 Next, hold down the CTRL key. While holding the CTRL key down, pick another
object, and click on it. It too will be elected (additional icon highlights). This can
be repeated for as many objects as you want included.
 The items do not need to be next to each other, only within the same window
(not merely the same visible area of the screen…use the scroll bar to display
another area of the same window). Just don’t accidentally click within the icon
area of the window while scrolling. If you do so all the other selections will be
lost. Stay within the scroll bar area.
 You may also let go of CTRL in between picks, but must hold the CTRL key back
down before clicking on another item. An example would be letting go of CTRL
while scrolling to a different portion of the window, then again holding down the
CTRL key before choosing more items.
 This use of the CTRL key to select can be coupled with the technique of using the
SHIFT key. In other words, let’s say you want to select a large number of files
which are clumped together (next to each other), but a few are not in the same
close proximity. First select the vast majority of items next to each other using
the SHIFT key technique describing above ("select first, shift, select last"). Now,
before clicking on another item, hold down the CTRL key. While holding the
CTRL key, you can add items away from the others already selected, without
losing the initial selections. You cannot however use the CTRL key technique
first, and then use the SHIFT key technique.
 Again, this way of adding to selections using the CTRL key works also after
selecting adjacent objects with the drag technique.
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Using the Cut/Copy/Paste/and Delete Commands
 These commands are in the Edit menu, or on the Home ribbon
typically.
o There are also "Keyboard shortcuts" for these commands.
 CTRL‐X = Cut
 CTRL‐C = Copy
 CTRL‐V = Paste
o They are also available on the Right‐click menu.
 If you merely look at the Edit menu or the right‐click menu, these commands will be "Grayed‐
out". An item on a menu which is "grayed‐out" indicates the command or option is not
currently available for use. In the case of Cut, Copy, or Paste, in order to use these commands,
something must have already been selected.
o The commands of Cut and Copy are Grayed‐out if nothing has previously been selected.
o The Paste command remains grayed‐out until something has been either Cut or Copied,
since without something in the Clipboard, there is nothing to Paste.
o Thus if nothing is currently selected, and nothing has previously been Cut or Copied, all
three commands, Cut, Copy, Paste, will be grayed‐out.
 When you Cut text, the selected text is immediately removed (disappears) from the document,
and is placed into storage in the Clipboard.
o The Clipboard is a difficult concept for some to understand, therefore I have included a
section on the next page to specifically discuss the Clipboard.
o A "cut" piece of text can be pasted repeatedly in most programs.
 When you use the Cut command on an object, (such as an icon, a file, or a folder) it does not
immediately remove the item. Instead, Windows is only made aware that you "desire or
intend" to move this item elsewhere. The object turns pale, awaiting to be "Pasted" at some
other position (into another folder, or onto another drive, or disk).
o If you never remember to "Paste" the object, nothing happens to it. It remains as is.
o A cut object can only be pasted once, not repeatedly like text can. If you want to
repeatedly place an object in multiple places (folders or disks), use the Copy command
instead (as stated below).
 Using the Copy command, whether text or an object is selected, places an identical copy of the
selected item (or items) into the Clipboard. There it remains; where it can be pasted once or
repeatedly as many times as desired.
 After placing the cursor in a location by clicking there, choosing the Paste command places the
text or object(s) stored in the clipboard at that place where the cursor is positioned.
o When pasting text, it is inserted at the point of the Insertion point
 Or replaces any text which is currently selected (meant to be replaced).
o Again, if grayed‐out, it means the Clipboard is empty (nothing was yet Cut or Copied).
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Using the Cut/Copy/Paste/and Delete Commands (cont'd)
 To differentiate between the CUT and the DELETE commands
o Regarding text,
 Cut removes the selected text and deposits (saves temporarily) it into the
clipboard for later use (Paste).
 Delete removes the text immediately without warning, and it is gone
permanently, and cannot be pasted.
o With objects,
 Cut command merely designates an object for subsequent moving. The object is
still visible but "dimmed".
 Delete removes the object immediately, but usually warns you first whether you
intended to delete it, before the object disappears forever.
 Forever is a long time. A deleted object traditionally goes to the Recycle
Bin, from where it can hopefully be retrieved if deleted unintentionally.
 Understanding the Concept of the Clipboard:
o You cannot see the Clipboard (unless you use "Clipboard viewer", and it is still not easily
understood), but it is ALWAYS there, even when it is empty.
o The Clipboard exists in the computer’s RAM (working memory).
 RAM is emptied (cleared out) each time the computer loses power, is shut down,
or is restarted, therefore so anything in the Clipboard is also discarded. Any text
saved to the clipboard and not pasted before the computer is turned off or
restarted is lost.
 However, objects currently chosen (selected) for cutting are not lost when the
computer is turned off or restarted. As previously explained, with objects, they
are only designated in the clipboard as "intended potentially" to be moved.
 If they are not pasted somewhere, only the memory of them being
designated (to be moved) is lost. In other words, the RAM forgets they
were intended to be moved, and they remain where they were originally.
o The Clipboard (except in special circumstances, as for example: recent versions of
Microsoft Office) can hold only one selection of text or objects at a time.
 Each time the Cut or Copy command is used, the entire Contents of clipboard is
discarded and replaced with the new selection.
 If you had Cut text, and failed to paste it somewhere before cutting or copying
something else (either text or object), the text is lost.
 Only one selection of anything is allowed in the clipboard at a time.
 Text shoves out objects;
 And objects shove out text.
 HINT: If you have text you wish to retain for later use, but need to "Cut" or
"Copy" something else first (and thus would lose it), start a new document and
deposit the text currently in the clipboard onto the new document. You can
then later retrieve it from there to insert into the original document when
desired. If you want to protect that text from loss, or have several pieces of text
for use another day, you can save that document containing cut text with a
"related name", such as "Current Document name fragments", or similar.
In our next lesson (Lesson 4), we will discuss Email, and often using these word processing techniques.
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